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Fabric Manager Client

Cisco Fabric Manager Client is a java-based GUI application that provides access to the Fabric Manager 
applications from a remote workstation.

This chapter contains the following sections:

• Information About Fabric Manager Client, page 5-1

• Launching Fabric Manager Client, page 5-2

• Fabric Manager Client Quick Tour, page 5-6

• Setting Fabric Manager Preferences, page 5-18

• Network Fabric Discovery, page 5-19

• Modifying the Device Grouping, page 5-20

• Controlling Administrator Access with Users and Roles, page 5-21

• Using Fabric Manager Wizards, page 5-21

• Fabric Manager Troubleshooting Tools, page 5-22

Information About Fabric Manager Client
Cisco Fabric Manager is a Java and SNMP-based network fabric and device management tool with a GUI 
that displays real-time views of your network fabric, including Cisco and third-party switches, hosts, and 
storage devices.

In addition to complete configuration and status monitoring capabilities for Cisco switches, Fabric 
Manager Client provides Fibre Channel troubleshooting tools. These health and configuration analysis 
tools use Cisco switch capabilities including Fibre Channel ping and traceroute.

Note You must use the same release of Fabric Manager Client and Fabric Manager Server.

Fabric Manager Advanced Mode
Advanced mode is enabled by default and provides the full suite of Fabric Manager features. Uncheck 
the Advanced check box in the upper right corner of the Fabric Manager Client to simplify the user 
interface. In this mode, you can access basic switch features such as VSANs, zoning, and configuring 
interfaces. 
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Launching Fabric Manager Client 

Note Network administrators must initially launch Fabric Manager Client using Fabric Manager Web Server, 
as described below. Once an administrator has installed the Fabric Manager Client icon on your desktop, 
you can double click on the icon to launch the Fabric Manager Client.

To launch Fabric Manager Client, perform this task:

Step 1 Open your browser and enter the IP address where you installed Fabric Manager Server, or enter 
localhost if you installed Fabric Manager Server on your local workstation. 

You see the Fabric Manager Web Server Login dialog box shown in Figure 5-1.

Figure 5-1 Fabric Manager Web Server Login Dialog Box

Step 2 Enter your user name and password and click Login.

You see the Fabric Manager Web Server Summary page.

Step 3 Click the Download link in the upper right corner of the page.

You see the Download page for Fabric Manager and Device Manager as shown in Figure 5-2.
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Figure 5-2 Download Page for Fabric Manager and Device Manager

Step 4 Click the link for either Fabric Manager or Device Manager.

If you are launching Fabric Manager Client for the first time, you see a message asking whether you want 
to create shortcuts for Fabric Manager, as shown in Figure 5-3.

Figure 5-3 Fabric Manager Create Shortcut(s) Message

Step 5 Click Yes to create shortcuts for Fabric Manager.

Note This message only appears the first time you launch Fabric Manager Client.

Step 6 When the software is installed and icons are created on your desktop, double-click the Fabric Manager 
icon to launch Fabric Manager.

You see the Fabric Manager Login dialog box shown in Figure 5-4.
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Figure 5-4 Fabric Manager Login Dialog Box

Step 7 Enter the Fabric Manager Server user name and password.

Step 8 Check the Use SNMP Proxy check box if you want Fabric Manager Client to communicate with Fabric 
Manager Server through a TCP-based proxy server.

Step 9 Click Login. After you successfully log in to Fabric Manager Server, you can set the seed switch and 
open the fabrics that you are entitled to access.

Note When you launch Fabric Manager Client for the first time or when there are no available fabrics, 
you see the Discover New Fabric dialog box.

You see the Discover New Fabric dialog box shown in Figure 5-5.

Figure 5-5 Discover New Fabric Dialog Box

Note Only network administrators can discover new fabrics.

Step 10 Set the fabric seed switch to the Cisco switch that you want Fabric Manager to use.

Note A Cisco switch running in NPV mode cannot be the fabric seed switch.

Step 11 Enter the user name and password for the switch.

Step 12 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:
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• If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 
(no privacy). 

• If you have configured the switch with your privacy protocol, choose your Auth-Privacy option.

Note If you want a clean discovery, remove the fabric and rediscover it.

Step 13 Click Discover.

You see the Control Panel dialog box shown in Figure 5-6.

Figure 5-6 Control Panel Dialog Box

Note You see a message in the dialog box when the server and client are running on the same 
workstation and there are unlicensed fabrics in the database. You also see a message when there 
are unmanaged fabrics (the state of the licenses is unknown).

Step 14 Check the check boxes in the Select column next to the fabrics that you want to open, or click Discover 
to add a new fabric.

Note Only network administrators can continuously manage or unmanage fabrics. For more 
information, see the “Selecting a Fabric to Manage Continuously” section on page 3-3.

Step 15 Click Open to open the selected fabrics.

Note If you have an incomplete view of your fabric, rediscover the fabric with a user that has no 
VSAN restriction.

To launch Fabric Manager Client from within a running instance of Fabric Manager, perform this task:

Step 1 Choose File > Open Fabric or click the Open Switch Fabric icon on the Fabric Manager toolbar. 

You see the Control Panel dialog box as shown in Figure 5-6.

Step 2 Check the check boxes in the Select column next to the fabrics you want to open and click Open. 
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Note Changes made using Fabric Manager are applied to the running configuration of the switches 
that you are managing. If you have made changes to the configuration or performed an operation 
(such as activating zones), Fabric Manager prompts you to save your changes before you exit.

Fabric Manager Client Quick Tour
This section describes the Fabric Manager Client interface shown in Figure 5-7.

Figure 5-7 Fabric Manager Main Window

1 Menu bar—Provides access to options that are organized by menus.

2 Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, 
and Help menus.

3 Information pane—Displays information about whatever option is selected in the menu tree.
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Note You can resize each pane by dragging the boundaries between each region or by clicking the Minimize 
or Maximize controls.

Menu Bar
The menu bar at the top of the Fabric Manager main window provides options for managing and 
troubleshooting the current fabric and for controlling the display of information on the Fabric pane. The 
menu bar provides the following menus:

• File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints 
the map, and clears (right-click on log) or exports the Fabric pane log.

• View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).

• Zone—Manages zones, zone sets, and inter-VSAN routing (IVR).

• Tools—Verifies and troubleshoots connectivity and configuration, as described in the “Fabric 
Manager Troubleshooting Tools” section on page 5-22.

• Performance—Runs and configures Performance Manager and Cisco Traffic Analyzer and 
generates reports.

• Server—Runs administrative tasks on clients and fabrics. Provides Fabric Manager Server 
management and a purge command. Lists switches being managed.

• Help—Displays online help topics for specific dialog boxes in the Information pane.

4 Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible 
error message.

5 Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also 
provides tabs for displaying log and event data.

6 Status Bar (left side)—Shows short-term transient messages, such as the number of rows 
displayed in a table.

7 Logical Domains pane—Displays a tree of configured SAN, fabrics, VSANs, and zones, and 
provides access to user-defined groups.

8 Physical Attributes pane—Displays a tree of available configuration tasks depending on the 
fabric, VSAN, or zone selected previously. Lists the switches and end devices in the logical 
selection.
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Toolbar
The Fabric Manager main toolbar provides icons for accessing the most commonly used menu bar 
options as shown in Table 5-1.

Table 5-1 Fabric Manager Client Main Toolbar

Icon Description

Opens switch fabric.

Rediscovers current fabric.

Searches the map.

Creates VSAN.

Launches DPVM wizard.

Edits full zone database.

Launches IVR zone wizard.

Launches SAN port channel wizard.

Launches Virtual Interface Group wizard.

Launches Virtual Interface wizard.

Launches FCIP wizard.

Launches iSCSI wizard.
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Logical Domains Pane
Use the Logical Domains pane to manage attributes for fabrics, VSANs, and zones, and to access 
user-defined groups. Right-click one of the folders in the tree and click a menu item from the pop-up 
menu. You see the appropriate configuration dialog box.

The default name for the fabric is the name, IP address, or world-wide name (WWN) for the principal 
switch in VSAN 1. If VSAN 1 is segmented, the default name is chosen from a principal switch with the 
smallest WWN. In order, the fabric names you may see are as follows:

• Fabric <sysName>

• Fabric <ipAddress>

• Fabric <sWWN>

Launches QoS wizard.

Configures users and roles.

Launches IP-ACL wizard.

Launches License Install wizard.

Launches Software Install wizard.

Performs switch health analysis.

Performs fabric configuration analysis.

Performs end-to-end connectivity analysis.

Monitors ISL performance. Brings up real-time 
ISL performance information for all interfaces in 
the fabric, in the Information pane.

Shows online help.

Table 5-1 Fabric Manager Client Main Toolbar (continued)

Icon Description
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To change the fabric name using Fabric Manager, perform this task:

Step 1 Choose Server > Admin.

You see the Control Panel dialog box.

Step 2 Double click the fabric name and enter the new name of the fabric.

Step 3 Click Apply to change the name.

Filtering

Fabric Manager has a filtering mechanism that displays only the data that you are interested in. To filter 
data, first select the fabric and VSAN from the Logical Domains pane. This action narrows the scope of 
what is displayed in the Fabric pane. Any information that does not belong to the selected items is 
dimmed. Also, any information that does not belong to the selected items is not displayed in the tables 
in the Information pane. The filter that you select is displayed at the top right of the Fabric Manager 
window (see Figure 5-8).

To further narrow the scope, select attributes from the Physical Attributes pane. The Fabric Manager 
table, display, and filter criteria change accordingly.

Physical Attributes Pane
Use the Physical Attributes pane to display a tree of the options available for managing the switches in 
the currently selected fabric, VSAN, or zone.

To select an option, click a folder to display the options available and then click the option. You see the 
table with information for the selected option in the Information pane. The Physical Attributes pane 
provides the following main folders:

• Switches—Views and configures hardware, system, licensing, and configuration files.

• Interfaces—Views and configures physical Fibre Channel, virtual Fibre Channel, Ethernet, SVC, 
and SAN port channel interfaces.

• Fibre Channel Services—Views and configures Fibre Channel network configurations.

• Events—Views and configures events, alarms, thresholds, notifications, and informs.

• Security—Views and configures switch management and FC-SP security.

• End Devices—Views and configures end devices.
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Information Pane
Use the Information pane to display tables of information associated with the option selected from the 
menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides 
buttons for performing one or more of the operations shown in Table 5-2.

Note After making changes, you must save the configuration or the changes will be lost when the device is 
restarted. 

Table 5-2 Information Pane Toolbar

Icon Description

Apply Changes Applies configuration changes.

Refresh Values Refreshes table values.

Create Row Opens the appropriate dialog box to make a new 
row in the table.

Delete Row Deletes the currently highlighted rows from the 
table.

Copy/Ctrl+C Copies data from one row to another.

Paste/Ctrl +V Pastes the data from one row to another.

Undo Changes/Ctrl-Z Undoes the most recent change.

Export Exports and saves information to a file.

Print Table Prints the contents of the Information pane.

Detach Table Displays a noneditable copy of the table in the 
Information pane in its own window, which you 
can move around the screen.
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Note The buttons that appear on the toolbar vary according to the option that you choose. They are activated 
or deactivated (dimmed) according to the field or other object that you choose in the Information pane.

Detachable Tables

Detachable tables in Fabric Manager let you detach tables and move them to different areas on your 
desktop so that you can compare similar tables from different VSANs. You can keep informational tables 
open from one view while you examine a different area in Fabric Manager. To detach tables, click the 
Detach Table icon in the Information pane in Fabric Manager.

Fabric Pane
Use the Fabric pane to display the graphical representation of your fabric. Table 5-3 describes the 
graphics you may see displayed, depending on which devices you have in your fabric.

Table 5-3 Fabric Manager Graphics

Icon or Graphic Description

Director class Cisco MDS 9000.

Non-director class switch.

Generic Fibre Channel switch.

Cisco SN5428.

Cisco Nexus 5000 series switch.

An orange line through a device indicates that the 
device is manageable but there are operational 
problems.

An orange X through a device or link indicates 
that the device or ISL is not working properly.

A red line through a device indicates that the 
device is not manageable.

iSAN
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If a switch or director is grayed out, Fabric Manager can no longer communicate with it.

The bottom of the Fabric pane has the following tabs:

• Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between 
fabrics by clicking on their respective tabs.

A red X through a device or link indicates that the 
device is down or that the ISL is down.

Fibre Channel HBA (or enclosure).

Fibre Channel target (or enclosure).

iSCSI host.

Fibre Channel ISL and edge connection.

Fibre Channel SAN port channel.

Fibre Channel over Ethernet (FCoE) connection.

IP ISL and edge connection.

IP port channel.

NPV connection.

Fibre Channel loop (storage).

IP cloud (hosts). This icon is also used to represent 
a fabric when viewing a SAN (multiple fabrics) in 
the Fabric Manager Fabric pane.

Any device, cloud, or loop with a box around it 
means that there are hidden links attached.

Table 5-3 Fabric Manager Graphics (continued)

Icon or Graphic Description
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• Log—Displays messages that describe Fabric Manager operations, such as fabric discovery.

• Events—Displays information about the SNMP traps received by the management station. This 
includes combination events as detected by discovery and important traps, such as license and 
SNMP.

You can view large fabrics in the Fabric pane easier if you do the following tasks:

• Turn off end device labels

• Collapse loops

• Collapse expanded multiple links (collapsed multiple links are shown as very thick single lines)

• Dim or hide portions of your fabric by VSAN

Note When a VSAN, zone, or zone member is selected in the VSAN tree, the map highlighting feature 
changes to identify the selected objects. To remove this highlighting, click the Clear Highlight button 
on the Fabric pane toolbar or choose Clear Highlight from the pop-up menu.

Context Menus

When you right-click an icon in the Fabric pane, you see a pop-up menu with options that vary depending 
on the type of icon selected. The various options available for different objects include the following:

• Open an instance of Device Manager for the selected switch.

• Open a CLI session for the selected switch.

• Copy the display name of the selected object.

• Execute a ping or traceroute command for the device.

• Show or hide end devices.

• View attributes.

• Quiesce and disable members for SAN port channels.

• Set the trunking mode for an ISL.

• Create or add to a SAN port channel for selected ISLs.

The Fabric pane has its own toolbar with options for saving, printing, and changing the appearance of 
the map. When you right-click the map, a pop-up menu appears that provides options (duplicated on the 
toolbar) for changing the appearance of the map.

Note You can launch web-based or non-web-based applications from the Fabric pane. To do this, assign an IP 
address to the storage port or enclosure, then right-click to bring up the pop-up menu and choose Device 
Manager.

Saving the Map

You can save the map in the Fabric pane as an image, or as an editable Visio diagram. You can save the 
map with or without labels on the links. The created Visio diagram is editable and saved in two layers:

• The default layer includes all switches and links in the fabric.

• The end devices layer includes the end devices and can be turned off to remove end devices from 
the Visio diagram.
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To save the map as a Visio diagram, choose Files > Export > Visio and choose Map or Map with link 
labels. The saved Visio diagram retains the viewing options that you selected from the Fabric pane. For 
example, if you collapse multiple links in the map and export the links as a Visio diagram, the Visio 
diagram shows those multiple links as one solid link.

The Show Tech Support option from the Tools menu also supports saving the map as a Visio diagram.

Purging Down Elements

The Fabric pane allows you to refresh the map at any time by clicking the Refresh Map icon. The 
Refresh Map icon redraws the map but does not purge elements that are down. To purge down elements 
you can perform one of the following actions:

• Click Server > Purge Down Elements. This purges all down elements in the fabric.

• Right-click the Fabric pane and choose Purge Down Elements.

• Right-click a down element and choose Purge. This action purges only this element from the fabric.

Note If you select an element that is not down and you purge it, that element will reappear on the next 
fabric discovery cycle.

Multiple Fabric Display

Fabric Manager can display multiple fabrics in the same pane (see Figure 5-8).

Figure 5-8 Fabric Manager’s Multiple Fabric Display Window
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Note The same user name and password must be used to log into multiple fabrics.

The information for both fabrics is displayed; you do not need to choose a seed switch. To see details of 
a fabric, click the tab for that fabric at the bottom of the Fabric pane, or double-click the Cloud icon for 
the fabric in the SAN tab.

Note Enclosure names should be unique. If the same enclosure name is used for each port, Fabric Manager 
shows a host/target enclosure connected to both fabrics. To fix this problem, you can either disable 
auto-creation or create unique enclosure names.

Filtering by Groups

You can filter the Fabric pane display by creating groups of switches or end ports. To create a group in 
Fabric Manager, perform this task:

Step 1 Right-click a switch or end port in the Fabric pane map and choose Group > Create. 

You see the Edit User Defined Group dialog box shown in Figure 5-9. 

Figure 5-9 Edit User Defined Group Dialog Box

Step 2 Enter a group name in the Name field. 

Step 3 Use the arrows to move additional switches or end ports from the Available column to the Selected 
column.

1 The Fabric view tab for fabric 172.23.46.152. When selected, the Fabric view displays fabric 
172.23.46.152.

2 The Fabric view tab for fabric 172.23.46.153. When selected, the Fabric view displays fabric 
172.23.46.153.

3 SAN tab (selected), showing two fabrics.
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Step 4 Click OK to save the group.

To add a switch or end port to an existing group in Fabric Manager, perform this task:

Step 1 Right-click a switch or end device and choose Group > Add To > YourGroupName. 

You see the Edit User Defined Group dialog box as shown in Figure 5-9.

Step 2 Use the arrows to move additional switches or end ports from the Available column to the Selected 
column.

Step 3 Click OK to save the updated group.

To filter the display by a group you have created, perform this task:

Step 1 Expand the Groups folder in the Logical Domains pane. 

You see the list of groups that you have created as shown in Figure 5-10.

Figure 5-10 Group Highlighted in Fabric Pane Map

Step 2 Click the name of the group that you want to filter.

In the Fabric pane, the switches or end devices in your group are shown normally; all other switches and 
end devices are shown in gray.

Step 3 Click the Groups folder in the Logical Domains pane to return the display to normal.

Note User-defined group tables are filtered based on switches in the group except for switches where 
CFS-controlled features are enabled when all CFS member switches are displayed to avoid 
misconfigurations.
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Status Bar
The status bar at the bottom of the Fabric Manager window shows the last entry displayed by the 
discovery process, and the possible error message on the right side. The status bar displays a message 
stating that something has changed in the fabric and a new discovery is needed. The status bar shows 
both short-term, transient messages (such as the number of rows displayed in the table) and long-term 
discovery issues.

Setting Fabric Manager Preferences
To set your preferences for the behavior of the Fabric Manager, choose File > Preferences from the 
Fabric Manager menu bar. You see the Preferences dialog box with the following tabs for setting 
different components of the application:

• General

• SNMP

• Map

The default General preferences for Fabric Manager are as follows:

• Show Device Name by—Displays the switches in the Fabric pane by IP address, DNS name, or 
logical name. The default setting for this value is Logical Name.

• Show WorldWideName (WWN) Vendor—Displays the world wide name vendor name in any table 
or listing displayed by Fabric Manager. Check the Prepend Name check box to display the name in 
front of the IP address of the switch. Check the Replacing Vendor Bytes check box to display the 
name instead of the IP address. The default is the Prepend Name option.

• Show End Device Using—Displays end devices in the Fabric pane using alias or pWWN alias. The 
default setting for this value is Alias.

• Show Shortened iSCSI Names—The default setting for this value is OFF.

• Show Timestamps as Date/Time—Displays timestamps in the date/time format. If this preference is 
not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).

• Telnet Path—Displays the path for the telnet.exe file on your system. The default is telnet.exe, but 
you need to browse for the correct location.

Note If you browse for a path or enter a path and you have a space in the pathname (for example, 
c:\program files\telnet.exe), then the path will not work. To get the path to work, you must 
manually place quotes around it (for example, “c:\program files\telnet.exe”).

• Use Secure Shell instead of Telnet—Specifies whether to use SSH or Telnet when using the CLI to 
communicate with the switch. If enabled, you must specify the path to your SSH application. The 
default setting is disabled.

• Confirm Deletion—Displays a confirmation pop-up window when you delete part of your 
configuration using Fabric Manager. The default setting is enabled (checked).

• Export Tables with Format—Specifies the type of file that is created when you export a table using 
Device Manager. The options are tab-delimited or XML. The default setting is Tab-Delimited.

• Show CFS Warnings—Shows warning messages if CFS is not enabled on all switches for a selected 
feature.



Send  comments  to  nx50 0 0 -doc feedback@c i sco .com

5-19
Fabric Manager Software Configuration Guide for the Cisco Nexus 5000 Series Switch

OL-16598-01

Chapter 5      Fabric Manager Client
Network Fabric Discovery

The default SNMP preferences for Fabric Manager are as follows:

• Retry request 1 time(s) after 5 sec timeout—You can set the retry value to 0-5, and the timeout value 
to 3-30.

• Trace SNMP packets in Log—The default setting for this value is OFF.

• Enable Audible Alert when Event Received—The default setting for this value is OFF.

The default Map preferences for Fabric Manager are as follows:

• Display Unselected VSAN Members—Displays the unselected VSAN members in the Fabric pane. 
The default setting for this value is ON.

• Display End Devices—Displays the fabric’s end devices in the Fabric pane. The default setting for 
this value is ON.

• Display End Device Labels—Displays the fabric’s end device labels in the Fabric pane. The default 
setting for this value is ON.

• Expand Loops—Displays the loops in the fabric as individual connections in the Fabric pane. The 
default setting for this value is OFF.

• Expand Multiple Links—Displays multiple links in the Fabric pane as separate lines instead of one 
thick line. The default setting for this value is ON.

• Open New Device Manager Each Time—Opens a new instance of Device Manager each time that 
you invoke it from a switch in your fabric. The default value is OFF, which means that only one 
instance of Device Manager is open at a time.

• Select Switch or Link from Table—Allows you to select a switch or link in the Fabric pane by 
clicking the switch or link in a table in the Information pane. The default setting for this value is 
disabled (unchecked), which means clicking a switch or link in the table does not change the switch 
or link selection in the Fabric pane.

• Layout New Devices Automatically—Automatically places new devices in the Fabric pane in an 
optimal configuration. The default setting for this value is OFF. In this mode, when you add a new 
device, you must manually reposition it if the initial position does not suit your needs.

• Use Quick Layout when Switch has 30 or more End Devices—Displays the default setting for this 
value (30). You can enter any number in this field. Enter 0 to disable Quick Layout.

• Override Preferences for Non-default Layout—Displays the default setting for this value (ON).

• Automatically Save Layout—If this option is enabled, any changes in the layout are automatically 
saved. The default setting for this value is ON. 

• Detach Overview Window—Allows you to easily center the Fabric pane on the area of the fabric 
that you want to see. (This feature is useful for large fabrics that cannot be displayed entirely within 
the Fabric pane.) Bring up the overview window by clicking the Show/Hide Overview Window 
button. It overlays the fabric window and remains there until you click the Show/Hide Overview 
Window button again. If you enable this preference, you can detach the overview window and move 
it to one side while you access the Fabric pane. The default setting for this value is disabled 
(unchecked).

Network Fabric Discovery
Cisco Fabric Manager collects information about the fabric topology through SNMP queries to the 
switches that are connected to Fabric Manager. The switch replies after having discovered all devices 
connected to the fabric by using the information from its FSPF technology database and the Name Server 
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database and collected using the Fabric Configuration Server’s request/response mechanisms that are 
defined by the FC-GS-3/4 standard. When you start Fabric Manager, you enter the IP address (or host 
name) of a seed switch for discovery.

After you start Fabric Manager and the discovery completes, Fabric Manager presents you with a view 
of your network fabric, including all discovered switches, hosts, and storage devices.

Modifying the Device Grouping
Because not all devices are capable of responding to FC-GS-3 requests, different ports of a single server 
or storage subsystem may be displayed as individual end devices on the Fabric Manager map.

To group end devices in a single enclosure to have them represented by a single icon on the map, Fabric 
Manager, perform this task:

Step 1 In the Physical Attributes pane, expand End Devices and then choose Storage or Hosts.

You see the end devices displayed in the Information pane.

Step 2 Click one of the devices in the Fabric pane, or click the Enclosures tab of the Information pane, and then 
click the device name (in the Name field) that you want to include in the enclosure.

Step 3 Enter a name to identify the new enclosure in the Fabric pane map.

Step 4 Click once on the device name in the Name field. To choose more than one name, press the Shift key 
and click each of the other names.

Step 5 Press Ctrl-C to copy the selected name(s).

Step 6 Press Ctrl-V to paste the device name into the Name field.

Note To remove devices from an enclosure, triple click the device name and press Delete. To remove 
an enclosure, repeat this step for each device in the enclosure.

Using Alias Names as Enclosures
To create an enclosure that uses the alias name as the name of the enclosure using Fabric Manager, 
perform this task:

Step 1 In the Physical Attributes pane, expand End Devices and choose Hosts or Storage.

You see the list of devices in the Information pane. The NxPorts tab is the default.

Step 2 Right-click the enclosure names that you want to convert to alias names and choose Alias > Enclosure 
as shown in Figure 5-11.
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Figure 5-11 Alias Enclosure

Step 3 Click the Apply Changes icon to save these changes. 

Controlling Administrator Access with Users and Roles
Cisco switches support role-based management access whether you are using the CLI or Cisco Fabric 
Manager. Role-based management access lets you assign specific management privileges to particular 
roles and then assign one or more users to each role.

The default-role contains the access permissions needed by a user to access the GUI (Fabric Manager 
and Device Manager). These access permissions are automatically granted to all users in order for them 
to use the GUI.

Cisco Fabric Manager uses SNMPv3 to establish role-based management access. After completing the 
setup routine, a single role, user name, and password are established. The role assigned to this user 
allows the highest level of privileges, which includes creating users and roles. Use the Cisco Fabric 
Manager to create roles and users and to assign passwords as required for secure management access in 
your network.

Using Fabric Manager Wizards
Fabric Manager Client provides the following wizards to facilitate common configuration tasks:

• VSAN—Creates VSANs on multiple switches in the fabric and sets VSAN attributes including 
interop mode, load balancing, and FICON.

• Zone Edit Tool—Creates zone sets, zones, and aliases. Adds members to zones and edits the zone 
database.

• SAN Port Channel—Creates SAN port channels from selected ISLs either manually or 
automatically. Sets SAN port channel attributes such as channel ID and trunking mode. 

• IP ACL—Creates ordered IP access control lists and distributes to selected switches in the fabric.

• License Install—Facilitates download and installation of licenses in selected switches in the fabric.

• Software Install—Verifies image compatibility and installs software images on selected switches in 
the fabric.

• Virtual Interface Group—Creates virtual interface groups (VIGs).
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• Virtual Interfaces—Creates virtual Ethernet interfaces and virtual Fibre Channel interfaces. 

Fabric Manager Troubleshooting Tools
Fabric Manager has several troubleshooting tools available from the toolbar or Tools menu. Procedures 
for using these tools are described in Chapter 31, “Troubleshooting Your Fabric.” This section provides 
a brief description of each tool:

• Zone Merge Analysis—The zone merge analysis tool (available from the Zone menu) allows you to 
determine if zones will merge successfully when two Cisco switches are interconnected. If the 
interconnected switch ports allow VSANs with identical names or contain zones with identical 
names, then Fabric Manager verifies that the zones contain identical members. The merge analysis 
tool can be run before attempting a merge or after fabrics are interconnected to determine zone 
merge failure causes.

• End-to-End Connectivity—Fabric Manager’s end-to-end connectivity analysis tool uses FC Ping to 
verify interconnections between Cisco switches and end-device (HBAs and storage devices) in a 
particular VSAN. End devices must be connected to a manageable switch through an active in-band 
or out-of-band management path. In addition to basic connectivity, Fabric Manager can optionally 
verify the following:

– Paths are redundant.

– Zones contain at least two members.

End devices are connected to a manageable switch (have a currently active in-band or out-of-band 
management path.)

• Switch Health Analysis—You can run an in-depth switch health analysis with Fabric Manager. It 
verifies the status of all critical Cisco switches, modules, ports, and Fibre Channel services. Over 
40 conditions are checked. This tool provides a very fast, simple, and thorough way to assess Cisco 
switch health.

• Fabric Configuration Analysis—Fabric Manager includes a fabric configuration analysis tool. It 
compares the configurations of all Cisco switches in a fabric to a reference switch or a policy file. 
You can define which functions to check and what type of checks to perform. The analysis can look 
for mismatched values, and missing or extra values. If all configuration checking is performed for 
all functions, over 200 checks are performed for each Cisco switch.

After the analysis is run, the results are displayed with details about the issues that were discovered. You 
can automatically resolve configuration differences by selecting them and clicking the Resolve button. 
Fabric Manager automatically changes the configuration to match the reference switch or policy file.
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